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ttthhhiiisss   iiisss   aaa   ttteeesssttt...      dddooo   nnnooottt   pppaaannniiiccc...   

ttthhhiiisss   iiisss   ooonnnlllyyy   aaa   ttteeesssttt...   

Our first meeting this month will test the club's desire for an inexpensive, easy-to-enter 
print competition.  Based on your survey results, many members reported a lack of 
confidence in their work and therefore, were reluctant to join in our exhibits and 
competitions. 

So we thought if you could print your own images at home on your 8 1/2" x 11" printer, 
rather than paying for an enlargement at a lab, perhaps you would enter into an Apprentice-
only competition.  To further your photographic education, the smaller number of entries 
will allow judges time to comment on each image.  In this way, you can learn what to do 
differently for future prints. 

We hope this new event will encourage more of our Apprentice photographers to get 
involved.  But hurry; deadline for entering is fast approaching. 

If it goes well, there may be more of these events.  If it's met with a lack of enthusiasm.... 
Like the headline says, "This is only a test". 

July  5 

MEMBERS'    
NIGHT 

Bring up to 3 images 

June 7 

APPRENTICE 
PRINT 

COMPETITION 

June 21 

SCAVENGER  
HUNT RESULTS 

Judith Sparhawk 

July 19 

ANNUAL SUMMER 
BAR-B-QUE 

Redlands Camera Club is a group of amateur, serious-amateur, and professional photographers who are interested 
in sharing experiences and advancing their skills.  Anyone with similar interests is encouraged to attend a meeting: 

no cost or obligation.  We meet at 7:00 pm on the first and third Mondays of every month at                     
Redlands United Church of Christ, 168 Bellevue Avenue, Redlands, CA. 
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E s t a b l i s h e d  1 8 9 6  

mailto:SNFelber@Yahoo.com


THE VIEW FROM HERE   
 Bruce Bonnett t   

This month our club is introducing a new print competition, one limited only to those who see themselves 
as apprentice photographers.  Each photographer who wishes to compete in any of our competitions places 
themselves in one of three experience classes; Apprentice, Intermediate, or Advanced.  The criteria that we 
suggest as a guide for an Apprentice is: "May be relatively inexperienced. May devote relatively little time 
and/or resources to photography. May be taking or have taken basic-level photography course work. May 
be re-exploring photography after a period of inactivity. Might not have been awarded ribbons in previous 
photographic competitions."  

This month our club is introducing a new print competition, one limited only to those who see themselves 
as apprentice photographers.  Each photographer who wishes to compete in any of our competitions places 
themselves in one of three experience classes; Apprentice, Intermediate, or Advanced.  The criteria that we 
suggest as a guide for an Apprentice is: "May be relatively inexperienced. May devote relatively little time 
and/or resources to photography. May be taking or have taken basic-level photography course work. May 
be re-exploring photography after a period of inactivity. Might not have been awarded ribbons in previous 
photographic competitions."  

Why a competition just for Apprentices?  The Board wanted to create an opportunity for encourage those 
who haven’t competed before or often to join the fun and take an important step in improving their skills.  
And, as this would limit the number of entries, it offers an opportunity for the entrants to not only hear 
their scores but also hear comments from the Judges on why the images earned those scores.  So I hope if 
you consider yourself an Apprentice that you have looked at the instructions on our website and are 
preparing for the June 7th competition.   From my own experience, nothing has helped my photography 
more than entering our competitions. I hope it will be the same for you and you’ll find yourself competing 
in the other classes in the future. 
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This competition will also provide an opportunity for other members of the club to participate as Judges.  
Frank Peele taught an outstanding workshop last month for those who wanted to learn to judge or wanted 
to learn how to better judge their own work. 

This competition will also provide an opportunity for other members of the club to participate as Judges.  
Frank Peele taught an outstanding workshop last month for those who wanted to learn to judge or wanted 
to learn how to better judge their own work. 

See you on the 7th and then on the 21st for the awards.  That night’s program will be the results of the 
Scavenger Hunt to LA’s Olvera Street and Chinatown.   Please read Judith Sparhawk’s article for details 
on the Scavenger Hunt field trip.  This should be a fun month with lots of opportunities to enjoy our form 
of art!  So grab you camera and start working that shutter button. 
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Don't forget, the Apprentice Print Competition will be coming up on June 7. The information forms and 
category descriptions are now on the web site, ready for download. 
Don't forget, the Apprentice Print Competition will be coming up on June 7. The information forms and 
category descriptions are now on the web site, ready for download. 

WEBMASTER/COMPETITION 
      Wayne (Woody) Wood 

The 2010 competition schedule and information documents are now on the web site.  The 2010 competition schedule and information documents are now on the web site.  

From now on all image files entered in the print and digital competitions, as well as Members Nights, 
will be named in the following manner: 
From now on all image files entered in the print and digital competitions, as well as Members Nights, 
will be named in the following manner: 

If the title of your image is Stormy Weather then your file name will be stormyweather.jpg.  From now on 
the title of your image will be the file name. Please don't put any punctuation, capitol letters or spaces in 
If the title of your image is Stormy Weather then your file name will be stormyweather.jpg.  From now on 
the title of your image will be the file name. Please don't put any punctuation, capitol letters or spaces in 
the file name.   

Redlands Camera Club   P.O. Box 7261  Redlands, CA  92375 
www.RedlandsCameraClub.com 
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UPCOMING PROGRAMS 
       Bruce Woodcock 

 JUNE  7TH                   
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Open to all RCC members in the Apprentice class, each entrant may submit up to a total of four images, in one or as 
many of the subject categories as desired. The categories are People, Places, Land/Seascapes, Animals, 
Photojournalism, Close-up, Open or Miscellaneous. Any image that has not won a ribbon in previous RCC 
competitions is eligible regardless of when the image may have been produced. Deadline for submittal of digital 
images for the print competition is 11:00 pm June 5. Take in for prints is June 7 between 6-7 pm. For detailed 
instructions see the RCC web site (www.redlandscameraclub.com) under Competition Information: 2010 Apprentice 
Print Competition. 

Apprentice Print Competition 

 JUNE  21ST                   

Scavenger Hunt results will be shown from the field trip to Olvera Street 
and Chinatown in Los Angeles. Participants will submit their “one best” 
image in each of the categories on the hunt list. It is always fun to see how 
our photographers have interpreted the items on the hunt list. The more 
photographers who participate, the more exciting the program is, so let’s 
head out to the City and bring back some great L.A. images to share!  

Scavenger Hunt Results: Judith Sparhawk 

 
 

 
FIELD TRIPS 
      Judith Sparhawk 

Our next Scavenger Hunt will be on Saturday, June 12th.  We will go to two L.A. locations for the hunt; Olvera 
Street and Chinatown.  They are within walking distance of each other and Union Station.  If you take the Metrolink 
train, you can easily do this trip on foot.  Fare is $15.50 round trip; $10.50 for 65+.  The SB station is at 1204 W. 3rd 
St.  We chose Saturday so if you prefer to drive, traffic should be light. 

Olvera Street (www.olvera-street.com) was the first settlement of Los Angeles, and includes historic buildings,                    
market vendors, restaurants, and a plaza where performances are frequently held.  Last time I was there, there was                   
a troupe of Aztec Dancers that had wonderful costumes and dances.  There will be a variety of things to photograph, 
and we should have some good items on the scavenger hunt list. 

Chinatown (www.chinatownla.com) should also be a good place to find scavenger hunt items.  It is nearby, and has 
many buildings with Chinese architecture, shops, temples, more restaurants, and other interesting things to see. 

For those of you who have not participated in a Photo Scavenger Hunt before, here's what to expect:  You will be 
provided with a list of items to hunt for with your camera.  Examples may be: "something cooked" or "bright 
colors".  Some will be more obvious than others; some will be more abstract: use your creative eye to capture an 
image that fits the list.  It is always a lot of fun, and we always see something new. 

After attending the Scavenger Hunt, bring your one best image for each item to the June 21st meeting.   A showing 
of our images will be the program that night.  It is always fun to see what everyone brings, and how creative you are 
in seeing the world around you.   

The Metrolink train leaves the SB Station at 8:45 a.m., arriving at Union Station at 10:15 am. We will meet at 
Olvera Street at the Stage near the south entrance between 10:30 and 10:45 to get your Scavenger Hunt sheet listing 
the items to shoot.  Don't be late or you may miss getting the list!   

A return train leaves Union Station at 4:45 p.m., arriving in SB  at 6:15.  However there are other times; go to  
www.metrolinktrains.com for their schedule.  

Directions to SB Metrolink station:  From 215 Fwy. exit and go West on 2nd St. to K St.  North on K and go West 
on 3rd St. 

http://www.olvera-street.com/
http://www.chinatownla.com/
http://www.metrolinktrains.com/


 

 

EXHIBITS 
      Carol Abidin Exhibit Schedule for 2010

 
Where 

Hanging 
Dates 

Take-In 
Times 

Redlands City Hall February 11 3 – 5 

Redlands Community Hospital 

Next Hanging: Redlands City Hall 

Thursday, June 3 from 3:00 to 5:00 
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March 6 10 - Noon 

Redlands City Hall 

Join your club members and bring a photograph to  
show the community our talents at RCC. See the Print  
Exhibit Rules for requirements and be sure to have 
your name and phone number on the back of our 
image. 

April 8 3 – 5 

Redlands Community Hospital May 8 10 - Noon 

Redlands City Hall June 3 3 – 5 

Redlands Community Hospital July 10 10 - Noon 

Redlands City Hall August 5 3 – 5 

Redlands Community Hospital 

If you have photographs currently hanging that have 
not been sold, you can let them hang again and/or bring 
new ones with a cost of only $3.00 for each. 

September 11 10 - Noon 

Redlands City Hall October 7 3 – 5 

Redlands Community Hospital November 6 10 - Noon 

Redlands City Hall 

After hanging your pictures, bring friends and family  
to show them what RCC is all about.  December 2 3 – 5 

 

By the way, I could use some help.  If you are 
interested in helping me hang these exhibits, please 
contact me at (909) 648-2584. 

PRINT EXHIBIT RULES 
The work must be yours, a current member of RCC.   

It must be ready to hang using wire eyes & wire; 

no saw tooth hangers

MEMBERSHIP 
Bessie Reece 

.   

 You may use a frameless presentation. 

Your name, title of the picture, and sale price (if for sale)             
must be on the back.  

There is a $3.00 fee for each work hung: cash or check. 
 Work left for another hanging will be charged again. 

Work removed but not retrieved after a new hanging               
will be charged a $3.00 storage fee.  

Work unclaimed within 60 days of removal will be considered 
abandoned and become the property of Redlands Camera Club       

for disposal or sale at its sole discretion. 
 

 

 

To date we have 142 members, including 19 new members for the 2010-2011 club year.  Several people 
have not renewed their membership for this year.  Remember, our year began April 1, 2010, and ends 
March 31, 2011.  To remain eligible for competitions, workshops, etc, your dues need to be current. 

By now everyone should have received a renewal notice in the mail or picked up their notice at a club 
meeting.  If you have any questions regarding the status of your membership, please see me at the next 
meeting. 

NEW MEMBERS 

Welcome to Larry Huddleston who recently joined us.  Larry became interested in photography at an 
early age with a Kodak 134.  He now shoots with a Canon Rebel and plans to upgrade soon.   Larry lives 
in Riverside with his wife of 25 years, Patricia, and family.  He was a truck driver of 25 years and is now 
semi-retired.  Larry is vice president of the Photo Artists Network of Riverside and also belongs to Shoot 
and Share an informal group from Riverside.  He is interested in shooting classic cars and landscapes.  
Larry joined Redlands Camera Club because he likes being involved with people of like interests and 
wants to be involved in our competitions. 

 



 

 
EDUCATION/WORKSHOPS 
      Frank Peele 

Our first two workshops of the club year were well 
attended, and the feedback from participants has been 
quite positive.  ShutterStories Rental Studio and 
Gallery has been a great location – a big thanks to 
owners Terry and Melissa Tippie for their generosity.  
ShutterStories, of course, is RCC’s newest sponsor, 
and their website is well worth checking out here. 

Workshop Schedule for 2010/2011

Where What Dates Times 

ShutterStories 
981 Iowa Ave. 
Riverside, CA 

Menu Magic 
How to set up your camera for best 

results 
Menus & Custom Functions: set 

your camera for quality & efficiency 
What settings are best for different 

situations? 
Why does my camera do that? 

April 29 6:00 – 9:00 

ShutterStories 
Competition Judging 

The workshop for Intermediate & 
Advanced Class members who 

wish to judge the upcoming 
Apprentice Class Print Competition 

May 10 6:00 – 9:00 

ShutterStories 
Beyond Automatic 

Control Exposure, Depth of Field 
and Motion to Make Your 

Photographs Look the Way You 
Want Them to Look 

July 6:00 – 9:00 

ShutterStories 

 In the “Menu Magic” workshop on April 29, Canon 
and Nikon experts Robert Fletcher and Troy Miller 
shared valuable information about setting up our 
cameras to give us the features we want to use, when 
we want them.  It’s no secret that today’s digital 
"wondercameras" can have a bewildering array of 
modes, options, and custom functions.  The trick is not 
only knowing what they do, but how to access them 
quickly when needed.  The level of enthusiasm among 
those attending expressed strong appreciation for the 
presenters and the information imparted. 

On-Camera Flash Techniques 
 Indoors and Out Sept. 6:00 – 9:00 

ShutterStories 
Up Close 

The Ins & Outs of Macro 
Photography 

Nov. 6:00 – 9:00 

ShutterStories 
Introduction to Studio Lighting 

Jan. 
2011 

6:00 – 9:00 

ShutterStories 
People Photo 

March 6:00 – 9:00 Lighting and Posing 

 

On May 10th, we had an excellent turnout for the 
“Competition Judging” workshop.  Geared toward the 
upcoming first-ever Apprentice Class-only small print competition, this hands-on session covered the 
qualities a judge should bring to the table, what makes a well-rounded judging panel, the proper setup for 
judging prints, and the elements of competition-worthy images.  After a number of prize-winning example 
images were presented and discussed, participants engaged in “practice runs” to hone their scoring and 
verbal critiquing skills.  It looks like we have a good mix of Intermediate Class and Advanced Class 
members in the pool of potential judges! 

Our next workshop, “Beyond Automatic”, will consider how today’s cameras have extensive intelligence 
but they still have no way to know just what creative ideas the photographer has in mind.  If you want to 
take your camera work to a higher level, attend this workshop to explore controlling exposure, depth of 
field, and movement of camera and subject during image capture.  Armed with new knowledge and 
confidence, you probably won’t ever want to use your camera's Automatic mode again.  Stay tuned for the 
announcement of details of this July event. 

Your workshop questions and suggestions are always welcome. Contact Frank here. 

 

Photoshop tip:  SMART SHARPENING 
Use Filter>Convert For Smart Filters, then choose Filter>Sharpen>Unsharp Mask.                   
Enter the desired settings and press OK.  This action will sharpen the entire image. 

In your Layers panel, activate the Smart Filter mask (white thumbnail) and, using a large soft brush      
set to black, paint to hide the sharpening in desired areas. 

To keep colors from shifting, open the Unsharp Mask layer’s Blending Options                      
and change the mode to Luminosity. 
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http://www.shutterstories.net/
mailto:frank.peele@verizon.net


MEMBERS’ GALLERY 
2010 Spring Digital Competition:  3rd Place Ribbons 

 

 

 

Photoshop & Elements Stroke tip:  USING THE RULE OF THIRDS 
Do you frequently use the Rule of Thirds in your compositions?  If you do, and would like to make        

cropping edits easier in post-production, set your Grids to reflect the Rule Of Thirds “Crash Points”.   
1. Go to Preferences>Guide, Grid, & Slices; set Gridlines every 33.33 percent with 1 subdivision.   

2. Next, use the Show/Hide the Grid (View>Show>Grid), or use the shortcut to switch it on and off. 
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SPONSORS 
Redlands Camera Club solicits sponsorship only from reputable businesses who sell high quality products and services at                  

reasonable prices, and whose business philosophies and customer service actions reflect fair decisions from the customer point of view.. 
Redlands Camera Club recommends its members consider the financial investment to our club  made by these sponsors,                  

and give serious consideration to them when making buying decisions. 
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On a space-available basis, Notices, Requests and For Sale ads may be posted by any member.  300 dpi JPEG pictures may be included..   
All postings must be photography-related and include your name and contact information.                                            

See Photogram Submissions box for deadline and submission information. 

RCC Bulletin Board 

July 4th Fireworks Field Trip
In July we will be shooting fireworks on 

July 4th — with the results to be shown at 
the Summer Bar-B-Que on July 15th 

Watch the website for more details. 

WATER COLORS:                                  
UNDERWATER IMAGES OF LIFE ON A CORAL REEF 

The Redlands Underwater Photography Club, which includes 
some RCC members, will hold an exhibit of underwater 

photographs at First United Methodist Church from June 4th - 25th. 

The church is located at 1 E. Olive Ave. in Redlands.  

The opening reception is on Friday, June 4, 5:00 - 7:00 p.m.  

The exhibit documents the beauty and diversity of sea-life       
in coral reefs, including Mexico, Indonesia, Borneo,             

and Papua New Guinea. 

Club members exhibiting their photographs will be               
Nancy Best, Christie & Lyle Hammond, Rick & Toni Hulbert, 

Quintin Lake, Marjorie Munson, Jean & Tim Timmerman,        
Bill Sperling, Susan Bangasser, and Ron Reaves. 
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Redlands United Church of Christ 

168 Bellevue, Redlands, CA 

Redlands Camera Club 

7:00 p.m. -- 1st & 3rd Mondays 

WHERE 

E-Mail:  _______________________________________________________ 

New Member    Annual Renewal     

Street Address: ________________________________________________ 

City: ________________________________  ST: _____ ZIP:  ___________ 

 Or  Mail to: P.O. Box 7261  Redlands, CA  92375 (make check payable to: Redlands Camera Club) 

Name: _____________________________  Phone:  (____)  ____ - _______ 

Want to join or renew your membership? 
 Complete this form and bring it to a meeting, along with $20 annual dues, 

WE MEET… 


